
1 

 

 
 

 

 
Welcome to the SuperDuper! User’s Guide! 

This guide is designed to get you up and running as fast as possible. We’ve 
taken the most common tasks people perform with SuperDuper!, each 
placed in its own chapter, and have provided step-by-step guidance 
(including lots of pictures). 

In here you’ll find out how to: 

• Back up your Macintosh for the first time 

• Update an existing backup 

• Schedule one or multiple backups 

• Store a backup alongside other files on a destination drive 

• Back up your Macintosh over a network 

• Exclude a folder from a backup 

• Restore files from a backup 

• Restore an entire drive in an emergency situation 

• Troubleshooting 

We’ve also included a complete program reference, and some more 
advanced topics, such as: 

• Creating a Sandbox 

• Maintaining a Sandbox 

• Applying (and recovering from) System Updates while running from a 
Sandbox 

Note that SuperDuper operates in two different “modes” – registered and 
unregistered. The unregistered version allows easy, complete and user-
specific backup clones to partitions, FireWire drives, and image files. 
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Once registered, SuperDuper allows you to schedule backups, quickly update 
backups with Smart Update (saving a lot of time), select “copy modes” 
other than Erase, then copy, create Sandboxes, fully customize the 
copying process using its unique Copy Scripts, save and restore settings, 
and avoid authenticating every time you copy. 

And, on top of that, it allows us to eat. 

Disclaimer 

Although SuperDuper! has been carefully tested, and should perform its 
functions without data loss, you use this software at your own risk and 
without any warranty. Always work with care when dealing with 

important data. 

IN NO EVENT SHALL SHIRT POCKET OR BRUCE LACEY BE LIABLE FOR ANY 
SPECIAL, INDIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS 
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS 
INTERRUPTION) ARISING IN ANY WAY OUT OF THE USE, REPRODUCTION, 
MODIFICATION AND/OR DISTRIBUTION OF THIS SOFTWARE, HOWEVER 
CAUSED AND WHETHER UNDER THEORY OF CONTRACT, TORT (INCLUDING 
NEGLIGENCE), STRICT LIABILITY OR OTHERWISE, EVEN IF SHIRT POCKET 
OR BRUCE LACEY HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGE. 

Copyright Notice 

This User’s Guide was written by David Nanian, and is Copyright © 2003-
2006 by Shirt Pocket. All rights reserved. 
SuperDuper! is Copyright © 2003-2006 by Bruce B. Lacey. All rights 
reserved. 
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Intro duction 
First, a little of the background and philosophy behind SuperDuper! 

Backing up is one of those things that never seems important until 
something goes horribly wrong, and things never go horribly wrong until the 
worst possible moment. Many backup programs do too much for the 
“normal” user: rather than making it easy and faster to get their data 
backed up, they overcomplicate the process to the point of frustration. 

That complexity can alienate and confuse users, and a proprietary, single-
vendor format leaves them without an alternative should a problem arise. 
We think it’s important that any solution be easy to understand, usable, 
and not have any “lock in”. 

Staying Balanced 

So, to determine whether that complexity is worth adding, it’s important to 
ask: when do most people need to restore? In general, we’ve found that 
“regular users” (and by that, I mean real “end users” like yourself) need to 
use their backups when: 

• They’ve made a “bad mistake”, like accidentally deleting an important 
file, or overwriting one (this kind of mistake is almost always 
recognized immediately) 

• Their drive (or computer) fails catastrophically, requiring a full restore 
• They sent their computer in for service, and it came back wiped clean 
• An application they installed, or a system update, caused their system 

to become unusable/unstable 
 

None of these situations require much other than a high-quality, up-to-date, 
full copy backup. (The last has a better solution than a backup – a  
“Sandbox” – which we offer in SuperDuper! as well.) 

Covering the 99% Case 

Given that, it’s pretty easy to see that most end users don’t need to retrieve 
a two-year-old (or even six-month old) version of a file from a backup. (An 
archive is a different thing: I’m talking about backups.) It’s just not that 
common a case. Developers, on the other hand, do need older versions of 
files, but they should be using a version control system: something a 
backup should absolutely not be. 

But, it is possible that a user won’t notice a problem in a “bad file” until 
they’ve already overwritten their backup, thus losing any chance of recovery 
with a “full copy”. While this is a problem for some, we have a good solution: 
rotate more than one full backup. 
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Any need for this kind of “temporal rollback” can be significantly reduced 
with a single rotation – say, on a weekly basis – and nearly eliminated with 
two, a weekly and a monthly. It’s incredibly rare that, on a non-archival 
basis, you’d need to go back more than four weeks. 

Simple to Understand 

The advantages to this kind of approach are many, not the least of which is 
that a non-technical user can easily understand what’s going on. It’s 
incredible how many people are confused by conventional backup 
terminology – “incremental”, “differential”, backups “sets” and the like. And, 
complicated storage mechanisms require a significant amount of expertise to 
perform a full recovery in the event of that all-too-common disaster: the 
total drive failure. 

Simple to Restore 

With SuperDuper!, recovery in that situation is literally a matter of booting 
from your most recent backup. And restoration – which, should you be on 
deadline, you need not do immediately – is just a matter of replacing the 
drive and copying back. 

Individual files are also easy to restore: just drag and drop from the backup. 
(Yes, applications without drag-and-drop install, or system-level files, are 
harder, but can typically be reinstalled/archive-and-installed should that be 
necessary… or, see the Sandbox for another rather unique idea...) 

Use It or Lose It 

SuperDuper!’s approach is the kind of thing that regular end users like 

yourself can do, and feel confident about. 

We know your time is valuable, and that a backup isn’t useful unless it’s 
recent and includes the files you expect. We’ve made the process of backing 
up extremely simple, and – with Smart Update – we’ve also made it fast and 
efficient. 

So, with all that in mind, let’s get started! 
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Backing Up Yo ur Macintosh for the First Tim e 

Step 1: Prepare for your backup 

First, you need to make sure you’ve got a place to store your backup. The 
best thing to use with SuperDuper! is an external FireWire drive, but due to 
various subtle incompatibilities, not all FireWire drives can act as a 
Macintosh startup drive, and this is never indicated on the package. 

Our general advice is to get a FireWire drive from Other World Computing, 
WiebeTech, LaCie or a Maxtor OneTouch. We have tested these drives for 
compatibility, and all work well with the Mac. 

Note 

Don’t use SuperDuper to copy a full boot image from a PowerPC 
Macintosh to an Intel Macintosh. The OS isn’t universal, and thus won’t 
work properly on the new Mac. 

Instead, use the Migration Assistant that appears during the first boot 
of your new Macintosh to copy your files, settings and applications 
from your old Macintosh (or from your copy) to the new one. 

USB drives cannot be used as a startup drive for PowerPC based 
Macintoshes, regardless of the program used. On top of that, USB drives 
have a large number of limitations regarding speed and – even if USB 2.0 
Hi-Speed rated – can slow down to USB 1.x speeds when used in 

conjunction with slower devices. 

So, if at all possible, please get a FireWire drive!  

Note 

You can also “push” a backup to a network drive. Please see Backing 
up over a network on page 18 for details. 

Once you’ve got your hardware situation resolved, it’s time to configure your 
software environment. 

Although it’s not strictly necessary, it’s usually a good practice to quit all 
running applications before performing a backup. Since there are some that 
aren’t visible, like the Microsoft Office Database Daemon, it’s easiest to log 
out of your account, and then log back in with the Shift key held down. This 
will prevent your startup items from running, and helps to ensure that your 
personal data doesn’t change during the backup. 

Note 

If you’re using FileVault, your home folder and all its data is stored in a 
single, large file that’s open and active when you’re logged in. Because 
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of this, you should create a non-FileVault account for use with 
SuperDuper! Then, log out of your FileVaulted account, into this new 
account, and run SuperDuper! from there. This ensures that the 
special FileVault volume is put away and backed up cleanly. 

Step 2: Start SuperDuper! and choose your source and destination 
volumes 

After launching SuperDuper!, you’ll need to choose the volume you want to 
back up, and the place to store the backup. You can back up to an internal 
drive, an external drive, or an image file (which can be stored locally or on a 
network volume). You can even copy to another computer: just put it in 
FireWire Target Disk Mode by powering on while holding down the T key, 
and connect it to the computer – it’ll act just like an external FireWire drive. 

 

But, my backup drive is grayed out! 

If your FireWire or USB drive is grayed out up in the destination pop-
up, the problem is that it’s either your startup drive (which you can’t 
copy to), or that it’s formatted for Windows instead of for the 
Macintosh. 

SuperDuper! can’t guarantee full-fidelity backups on a FAT32 
(Windows) volume for a number of reasons, including the fact that 
FAT32 doesn’t support files greater than 4GB in size. So, even though 
you could store a backup on the drive using a disk image, that backup 
will fail once the image reaches 4GB. 

To fix this problem, use Disk Utility to erase the drive (of course, make 
sure you don’t have any data on it you want to keep first), and use 
Mac OS Extended (Journaled) as the format. While you’re there, 
you should usually zero the drive (both the data and free space under 
Tiger): this tests the drive surface, remaps any bad or weak spots, and 
helps to ensure your first backup will be a successful one. 

Once that’s done, you’ll be able to select the drive in the destination 
pop-up. 
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Caution! 

If you choose a destination volume that already has files on it, those 
files may be overwritten by the backup operation. The exact behavior 
of SuperDuper! is defined by the During copy section of Options…, 
discussed below. 

So, this might be a good opportunity to partition the drive with Disk 
Utility: it’s always best to isolate your backup from your regular 
“storage”! 

See Storing a backup alongside other files on a destination 

drive on page 16 for another option. 

Step 3: Choose your backup script 

There are two different built-in Backup scripts included with SuperDuper!: 
Backup – all files and Backup – user files. 

  

Backup – all files (highly recommended) does what it says: it creates a 
complete backup of the selected volume. If the source is a boot volume, this 
is often called a “bootable clone”, and can be used to start your system in 
the event of a catastrophic hard drive failure. Clones make great backups for 
users who are backing up for safety, and where the need to recover many 
previous versions of a document is not necessary. 

Backup – user files is similar, but it does not create a bootable backup. 
Instead, it only backs up user specific files in the Home directories of the 
various accounts on your system (as well as the special iSync files that are 
stored elsewhere in Panther). This type of backup is not bootable, since it 
doesn’t contain operating system files, but is useful for storing copies of your 
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personal data. It’s much harder to recover from a disaster if you’ve only got 
your personal files backed up. 

Although Backup – user files takes less space, please remember: disk 

space is cheap, your time is not! In the event of a disaster, recovery 

will take much longer if you don’t have a full backup. 

Note 

The other two default scripts, Sandbox – shared users and 

applications and Sandbox – shared users should not be used to 
create conventional backups. Rather, these create a Sandbox, a 
“system checkpoint” which is discussed fully in Creating a Sandbox 

on page 34. 

Step 4: Set your options 

At this point, you’ve selected what you want to back up, and where you 
want to back it up to. The next step is to tell SuperDuper! how to perform 
the backup. 
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Click the Options… button, and you’ll be presented with the following: 

 

The various options are discussed more fully in SuperDuper! Options in 

detail on page 41. For now, ensure that Repair permissions… is 
unchecked, and concentrate on the selections in the During copy pop-up. 
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If you’re running an unregistered copy of SuperDuper!, you can only choose 
Erase, then copy…. This option erases the destination volume before 
writing to it. While this ensures that the result is an exact copy, if you’re 
performing a second or third backup, it also copies all your data over again, 
taking extra time. 

Smart Update… is similar, in that the result is an exact copy of the source. 
The difference is that it only copies (or deletes) files and folders as 
necessary. This takes much less time after the first backup, doing in 
minutes what could otherwise take hours. 

Both of the previous options will remove files from the destination 
volume that aren’t present on the source volume, or selected by the 
copy script. This means that if you choose Backup – user files, 
SuperDuper! will remove any files from the destination volume that 
are outside the /Users folder. 

Similarly, if you have stored a file on the destination volume that you 
want to keep, but isn’t present on the source, it will be removed. 
Remember: by definition, Smart Update does exactly what Erase, 

then copy would do. It just does it faster! 

Copy newer and Copy different, the other two During Copy options, 
control what SuperDuper! does when it copies a file from a folder on the 
source volume to the destination, and finds there’s already a file in that 
location with the same name. 

When Copy newer is selected, the file on the destination is replaced with 
the one from the source if the file on the source has a newer (more recent) 
modification date. 

Copy different replaces the file on the destination if the source file is 
different (not necessarily newer) in date, size, HFS+ metadata, attributes, 
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etc. So, the file on the destination is replaced if it’s not exactly the same as 
the source file. 

In both cases, files on the destination that are not on the source are left as-
is. 

Note 

A bootable copy can only be ensured if you use Erase, then copy or 
Smart Update as the During copy option. 

Also, remember that options other than Erase, then copy… are only 
available in the registered version of SuperDuper! 

Step 5: Verify your choices 

It’s always a good idea to verify the selections you’ve made, to ensure you 
haven’t accidentally chosen the wrong volume or option. SuperDuper!’s 
unique What’s going to happen? section allows you to quickly ensure that 
you’re going to get what you asked for. Take a moment to review: it’ll save 
you time in the end. 

 

Step 6: Click “Copy Now”  

Simple enough: one click (and a final confirmation) and SuperDuper! 
handles the rest! 
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Updating an existing backup 
Each time you launch SuperDuper!, all of your settings from the previous 
session will be restored, including the source and destination volumes, if 
available. 

If you want to update an existing backup, and you’ve registered your copy of 
SuperDuper!, click Options… and then change the During copy setting to 
Smart Update…. When you click Copy Now, SuperDuper! will only make 
the changes necessary – replacing, adding and removing files and folders – 
to ensure the backup exactly matches the source; this will typically only take 
a few minutes. 
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Scheduling o ne o r mo re backups 
The thing about backups is that you can’t do them reactively: you must 

back up proactively, or there’s little point. So, you need to run 
SuperDuper! regularly – and remembering to do so can be a pain. 

Fortunately, you don’t have to remember! Instead, you can schedule one or 
many backups, and – in classic SuperDuper! style – it’s really easy to do. 
Here’s how. 

First, set up your backup the way you normally would, using the main 
SuperDuper! window. Select your source and destination volumes, your 
script, and get the options just the way you want them. 
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Then, instead of clicking Copy Now, click Schedule…  

 

You use this sheet to tell SuperDuper! the “when” that goes with your 
“what”. Select one or more weeks or days on which the backup should 
occur, as well as the time. When you’re happy with your choices, click OK, 
and a new entry will be added to the list of scheduled copies. 

Note 

You can schedule as many backups as you’d like, even at the same 
time of day: you don’t have to guess how long one will take, and 
schedule another backup after the completion of the first. 

If more than one backup is scheduled for the same time, SuperDuper 
will automatically start them one after another until all have 
completed. 
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The Next copy column shows when the next scheduled copy will occur, and 
– if one has already happened – the Last copy column shows when it ran 
last time. If the last copy failed, the entire line will be red: this is an easy 
way to see if things are working as expected. 

 

If you want to see the log for a given run, select it in the table and click 
Show Log… 

Usage tip 

SuperDuper! does not have to be running for a schedule backup to 
take place, but the user who scheduled it does have to be logged in, 
with their account in front (if Fast User Switching is active), and the 
screen must be unlocked. 

If your Macintosh is asleep when the time comes to run the backup, 
SuperDuper!’s scheduling won’t wake it up, so the backup won’t run. 
The way to handle this is to use the Energy Saver Preference Pane in 
System Preferences to schedule a wake (or “start up”) event for a 
minute before the backup is scheduled to run. 

You can change the schedule for an existing backup by clicking Edit… (or 
double-clicking the item in the table). 

Note 

Other than the date/time, or temporarily disabling an individual item, 
your backups cannot (currently) be changed once scheduled. If you 
want to change the volumes or options, you’ll have to delete and 
recreate the entry. 
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Sto ring a backup alo ngside other files o n a 
destination driv e 
In general, we strongly recommend that you store a backup on its own 
volume or partition, on a FireWire or internal drive that supports booting the 
Macintosh. Doing so makes it really easy to recover, saving you time – a lot 
of time – should a disaster occur. 

And not to toss a wet blanket on the optimist but, eventually, a disaster will 
occur. 

But, sometimes, dedicating a volume to backing up is impractical, and 
partitioning is either inconvenient or impossible. In those cases, you should 
use a Read/Write “Sparse” Image. 

With a Sparse Image, your files are kept in a “virtual” disk, which is actually 
stored in a single file. This file can be placed anywhere, including on a 
network volume. When mounted (which you do by simply opening the 
Sparse Image file), the “virtual” drive looks just like a local disk, and can be 
backed up to like any other. You can even Smart Update it! 

There are some disadvantages, though: 

• Since Sparse Images are not “real” drives, but rather simulated drives 
stored in a file, they’re potentially less reliable than real drives. (Note, 
though, that Apple uses sparse images for FileVault, so this shouldn’t 
be a big concern.) 

• Similarly, since Sparse Images are not real drives, they’re inherently a 
bit slower. 

• Finally, since they’re not physical drives, images of any type cannot be 
used to start up your Macintosh. However, the contents retain their 
bootable properties and – once restored to a real drive – can act as a 
startup drive. 

So, with that in mind, using sparse images is quite simple. 

Choose your source drive normally. In the destination pop-up, choose Disk 
Image…  
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You’ll be presented with the following panel: 

 

Choose the location for your sparse image, and enter the name you want it 
to have. Make sure the pop-up at the bottom is set to Read/Write 

“Sparse” Image. 

Note 

Do not store a sparse image on a FAT32 volume. FAT32 volumes have 
a 4GB single file size limit, and fail pretty spectacularly when this limit 
is reached. As with direct-to-disk backups, please erase any FAT32 
volumes with Disk Utility, and use Mac OS Extended (Journaled) as the 
format. 

That’s all there is to it! SuperDuper! will automatically create the sparse 
image, if necessary, mount it, back up to it, and unmount it when it’s done.  
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Backing up ov er a netwo rk 
Backing up to a network volume with SuperDuper! is as easy as backing up 
to a local volume, with a few special considerations. 

First, SuperDuper! cannot write directly to the network volume itself. 
Instead, you must store your backup in an image – preferably a Read/Write 
“Sparse” Image. 

To do this, mount the network volume, and then choose Disk Image… from 
the destination pop-up. Then, select the network volume and folder where 
you want to store the image, and name it appropriately. 

 

Make sure the pop-up at the bottom is set to Read/Write “Sparse” 

Image, then click Save. In Options…, set things as desired (I recommend 
using Smart Update) and click Copy Now. 
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The next time through, SuperDuper! will automatically mount the network 
volume, mount the image, back up to it and unmount it when done. Again, 
make sure you use Smart Update to ensure the fastest operation! 

Note 

It’s very important that the network drive support files larger than 
4GB. FAT32-based servers or NAS devices will not work, and fail 
pretty spectacularly when this limit is reached. 

Please ensure the network volume is HFS+, NTFS or ext3, all of which 
support large files. 
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Excluding files or fo lders fro m a backup 
Although we recommend that a backup include all of the files from the 
source drive, it’s sometimes necessary – or desirable – to be more selective. 

SuperDuper!’s Copy Scripts allow a user to easily customize the files and 
folders that are copied, by simply building on the scripts we’ve provided. 
Don’t worry, this isn’t programming: scripts are just a way of selecting files 
and folders, and letting SuperDuper! know what to do with them. 

With that in mind, let’s create a simple script that builds on the Backup – 
all files script by doing everything it does, but – in addition – ignores the 
Pictures folder for all users. 

The first step is to choose File > New Copy Script: 
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In the Description tab, enter a description that tells the user what this 
script does. This description will appear in the What’s going to happen? 
section of the main window. 

You can use the placeholders (source) and (target) (with the parentheses 
included) to refer to the two volumes selected in the main interface. This 
gives the user more context for the script’s actions, and is preferred to using 
generic terms like “source” or “destination”. 
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In the Included Scripts tab, include the script(s) whose base functionality 
you wish to modify. In this case, we’re going to add to Backup – all files: 
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Finally, switch to the Script Commands tab. Here, we actually modify the 
behavior of the included scripts by adding additional commands. In this 
case, we want to ignore the Pictures folder for all users. So, the first step is 
to navigate to the Pictures folder in the small file browser, and click Add: 
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The command automatically defaults to ignore. While this will work for the 
user we’ve selected, if you have other users, their Pictures folders will be 
copied. Rather than find all the users and add separate ignore statements 
for each, we can use a wildcard (discussed in detail in Copy Scripts on 
page 46). The * wildcard will match any visible files in the folder specified – 
in this case, /Users. So, we double-click the table entry to edit it, and modify 
the user name to use the wildcard: 
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Then, save the script with an appropriate name in the default location, and 
select it, instead of Backup – all files, in the main window. 

 

Click Copy Now, and all files that would normally get copied with Backup – 

all files will be copied except for the Pictures folder. 

(Another, more in-depth example can be found in Copy Scripts on page 
46.) 
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Restoring files from a backup 
Recovering a single file – or a few files – is quite easy. Just attach the 
external drive or mount the backup image, and drag the file back to the 
proper location using the Finder. 

That’s all there is to it! 
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Recov ering from a disaster 
When things go horribly wrong, the first thing to remember is: 

Don’t panic. 

It’s a cliché, I know, but don’t head for a full restore before trying other 
options, such as using Disk Warrior, doing an Archive and Install, or other 
similar approaches. If you’re running from a Sandbox (see Creating a 

Sandbox on page 34), start up from the original! 

If the disaster remains it’s time to restore from your backup. 

There are many different approaches to the restore, depending on where 
you’ve stored your backup, and the capability of your particular Macintosh. 

Restoring from a bootable backup 

First, if you’ve backed up to an internal partition, you can start up from it 
(hold down the Option key when you start your Macintosh and select the 
backup partition), and then use SuperDuper! to restore the data to the 
original location. (This works just like backing up, above.) 

Similarly, if you’ve stored a bootable backup on an external FireWire drive, 
and your Macintosh is capable of starting up from FireWire, hold down the 
Option key when you start, select the FireWire drive, and use SuperDuper! 
to perform the restore. 

Restoring when you can’t start up from your backup 

If you have a backup image or volume, but can’t start up from it, you can 
still restore using your OS X install disc. To do so: 

• Start up from the OS X Install disc. 

• When the Installer starts, choose “Disk Utility” from its Application 
menu. 

• Once the Disk Utility starts, select the drive you want to restore to, 
and switch to the Restore tab. 

Note 

If you’re restoring from a sparse image, as in the following screen 
shot, first open the image by choosing File > Open Image… in Disk 
Utility. Then, use the volume that appears (e.g. “Backup”, below) as 
the source. 
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• Follow the instructions on the Restore tab: the backup created by 
SuperDuper is fully compatible with Disk Utility’s Restore function. 

• Once the backup has been restored, restart your computer with Option 
held down, and select it as your startup volume. 

Recovery accomplished! 
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Troubleshooting 

When things go wrong, don’t walk away… 

Sometimes, your copies aren’t going to work as expected. It’s important to 
recognize that SuperDuper! is very conservative in operation, and will not 
allow a copy to complete if any errors occur. 

This is a different approach than you might be used to, but SuperDuper! 
doesn’t know how important a file is to back up and – very often – the user 
doesn't either. If the failure is on a "boot-critical" file, for example, not 
backing it up could mean you've got a rather ineffective backup! 
 
So, we stop the backup. If you know what the file is, you can take 
appropriate steps, and Smart Update will automatically continue from the 
proper location (it won't copy files that are already there, and will do any 
rearranging that the "fix" requires). If you don't, support is here to help you 
make an informed decision on how to continue. 

Physician, (attempt to) heal thyself 

If you encounter an error, click the Show log… button. The log viewer 
window will open, and show you what happened during the last copy. 

 

At the bottom of the log in red, usually preceded with ERROR or WARNING, 
is the reason for the failure. 
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Typically, one of two things has occurred. There’s not enough space to copy 
the file, or an I/O (or other) error has prevented the file from being read or 
written. 

Out of space 

Out of space errors are signaled by a message in the log similar to “No space 
left on device”. This could mean the disk is really full, or that damage to the 
file is making OS X think the disk is full. 

If the destination volume is actually full, and the source volume should 
definitely fit on the destination, this could be because Smart Update needs 
more “working space”. This is because Smart Update works its way through 
a volume in a single pass, and copies or deletes files and folders as it 
encounters them. If you rename a large folder or file, or add one folder and 
delete another, Smart Update may encounter the new file or folder before 
it deletes the old. In that case, it temporarily needs enough disk space to 
hold both the old and new versions. 

To work around this problem, simply perform a single Erase, then copy…, 
and then switch back to Smart Update. 

A file that’s being aggressively written to at the moment it’s being backed up 
can also cause a volume to become full. When this happens, the file can look 
bigger to OS X than it really is, which fills the destination volume. 

In this situation, you should also use Erase, then copy, and make sure that 
no programs are running during the copy by logging out and back in with 
Shift held down. 

If the file listed in the log isn’t large, and isn’t being actively written to, it’s 
possible that the file itself is damaged. To repair, use Disk Utility or 
DiskWarrior to check the structure of the source and destination volumes, 
then try the backup again. (Note that you might need to restart from your 
OSX Install Disc to repair the source volume. To do so, boot from the disc, 
then choose Disk Utility from the Installer menu. Use that to repair the 
disc’s structure (not permissions – use the buttons on the right hand side). 
Then, boot back and give the backup another try. 

I/O Errors 

I/O errors are the second main kind of trouble you could run into. An I/O 
error happens because: 

• The source or destination drive has a low-level surface error that’s 
preventing a successful copy 
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• Low-level software is interfering with the copy itself, such as AntiVirus 
software (which tries to scan every file copied, a time consuming and 
ultimately pointless operation) 

• Some hardware is causing communication problems on the FireWire 
bus 

You might ask yourself: why? The drive was working fine. Disk Utility didn’t 
indicate any problems. Why does SuperDuper fail when everything else 
seems to be working OK? 

I know it’s frustrating. But it’s important to recognize that Disk Utility does 
not actually test the entire drive. Instead, it checks to see if your folders are, 
generally, structured properly. It doesn’t try to actually read all your files: 
something we must do to copy them. 

Similarly, your system might be working fine because the file that’s having 
trouble is not one that’s typically used. If the file had never been accessed, 
you’d never know there was an issue… until you ran SuperDuper. 

Other devices attached to the system could also be doing weird things, and 
that can cause problems with large copies that wouldn’t necessarily show up 
when doing “smaller scale” things. iSights are particularly troublesome, and 
will sometimes cause FireWire drives to malfunction. Powering everything off 
will often resolve the issue, although disconnecting the iSight is sometimes 
necessary. 

So, let’s fix the problem. The very first thing to try is to simply restart your 

Macintosh, and give the backup another shot. Often, that’s all that’s 
necessary. But if it doesn’t work, you should run Disk Utility to repair the 
source and destination volumes. If one is your boot volume, that’s not 
always easy, because you can’t repair the volume you started your 
Macintosh from. 

Fortunately, you can get around this: just start your Macintosh from your OS 
X install DVD/CD, and run Disk Utility from the Installer menu (the bold one, 
at the top of the screen, next to the Apple menu). Repair the volume (don’t 
repair permissions – use the buttons on the right side of the Disk First Aid 
tab), and then boot back. Then, try the copy again. 

If the error reproduces again with the same file, then the problem is likely 
an error in that file. 

If the file is one of yours, try to duplicate it with Finder. If that succeeds 
without error, delete the original, empty the Trash, and rename the copy to 
the original name, then perform the copy again. If the duplicate fails, the file 
is likely damaged beyond repair, and you should delete it and empty your 
trash. 
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On the other hand, if you get a failure on a different file, the cause could be 
low-level software. If you’ve got an anti-virus program (or something 
similar) installed, turn off its “Auto Protect” functionality and try again. 

If that doesn’t help, it might be a hardware problem. Try simplifying your 
FireWire bus by disconnecting all devices except for the external drive 
(especially iSight cameras) and give the copy another try. If that doesn’t 
work, try switching ports or cables. 

Finally, if the damaged file is part of the system, it’s more difficult to repair 
directly due to the fact that the system – not you – owns it. If you’re using 
Panther or Tiger, I’d suggest an archive-and-install of the system. Make sure 
everything is OK, then delete the Previous Systems folder at the top of that 
drive and empty your trash. That should resolve the issue. 

Remember, we’re here to help 

At Shirt Pocket, we know that you can’t have a great product without 
providing great support. When you get stuck, we’re here for you. 

Right in the Log window there’s a button you can use to contact support. If 
you’re stuck, click that button, and you’ll see this sheet: 
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Choose the problem type, enter a summary and description, and click Send 

to Shirt Pocket. This will send the description you entered, plus the log 
information, to us, and we’ll help you figure out what’s going on. 

You can also get in touch with us in other ways. 

First off, you can join us on the Shirt Pocket web site, at 
http://www.shirt-pocket.com. Our discussion forums are always open, 
and are a great place to talk about SuperDuper with other experts, including 
representatives of Shirt Pocket. The forums are an especially good way to 
ensure that other users can benefit from your comments and questions. 

You can also contact us for one-on-one support by choosing one of the 
support options in the Help menu, or contacting us at support@shirt-

pocket.com. We’re here to help, and strive to answer all questions within 
24 hours. 

http://www.shirt-pocket.com
http://www.shirt-pocket.com/forums
mailto:support@shirt-pocket.com
mailto:support@shirt-pocket.com


34 

 

 
 

 

Creating a Sandbox 

Sandbox — system recovery without downtime! 

Back in the days before OS X, it was relatively easy to back up the “System 
Folder”. It wasn’t that large, really, and could be copied to another drive or 
even burned to a CD. If anything went wrong – a bad extension, corrupted 
preferences – you could restore the System Folder and get back to work 
relatively easily and painlessly. 

With the advent of OS X, the system itself became more complex. While it’s 
much more stable, it’s also much more difficult to preserve a working 
version as a “checkpoint” – and when things go wrong, it’s not nearly as 
easy to restore a working environment. 

A SuperDuper Sandbox is the solution to this problem. 

A Sandbox is a bootable copy of your system, stored on another hard drive 
or partition, that shares your personal documents and data with the 
original. In the past, you might have stored this copy away in a drawer as a 
backup. With SuperDuper, you actually use the Sandbox as your startup 

volume. 

You can safely install any system updates, drivers or programs in the 
Sandbox, without worrying about what might happen to your system. If 
anything goes wrong, you can simply start up from the original system. 
SuperDuper has preserved it in its original, pre-disaster state – but all your 
new and changed personal documents are totally up to date. Within 

minutes, you’re up and running again – without having to go through a 

difficult and time-consuming restore process. 

Of course, the original volume doesn’t have any of the programs or system 
updates that you might have installed since you made the copy. That’s a 
good thing, since they’re probably what caused the problem in the first 
place!  

A Sandbox is different than (and doesn’t substitute for) a rigorous regular 
backup program. While backup programs excel at recovering specific files, 
they’re less useful when you don’t know what’s wrong, and therefore don’t 
know what to restore! Restoring an entire system can take a long time, and 
it’s difficult to restore a running system without going through the “disaster 
recovery” process… and that can take hours. 

With a Sandbox, you only need to start up from the original volume! 

Creating a Sandbox is a simple process, but it requires that you have a place 
to store it. Usually, this involves creating a partition somewhere so you’ll 
have two startup drives: the original, and the location of the Sandbox. 
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Note 

Partitioning is discussed in full in Appendix – Partitioning Your 

Laptop for a Sandbox on page 55. From this point forward, it’s 
assumed that you have both an original drive volume (which we’re 
calling Macintosh HD) and a blank (or erasable) volume for the 
sandbox (which, for clarity, we’re calling Sandbox). 

Once you’ve got your partitioning set up, start SuperDuper. Choose your 
startup disk (e.g. “Macintosh HD”) in the first pop-up, and the location of the 
sandbox (e.g. “Sandbox”) in the second. 

 

There are two Sandbox scripts to choose from. One, Sandbox – shared 

users and applications, is usually a better choice. It doesn’t copy your 
user data or applications. Instead, it leaves it on (in this case) Macintosh HD, 
and shares1 them with Sandbox. The data remains on Macintosh HD, but 
can still be accessed normally from the Sandbox. 

Apple-provided applications, such as iDVD, iTunes and iSync, are copied in 
full. This ensures that any system updates that affect those applications are 
isolated to the Sandbox volume. 

The other, Sandbox – shared users, also shares your user data between 
the two volumes, but makes a full copy of everything else, including your 
applications. 

Note 

While Sandbox – shared users isolates virtually every aspect of your 
system, it’s typically unnecessary: it’s quite rare that applications 
themselves become damaged in a way that prevents a system from 
operating, or can’t be fixed by simply reinstalling the application itself. 
This script also requires far more disk space, since complete copies of 
all your applications are stored on Sandbox. 

                                   

1 When data or applications are shared, they remain on the original drive 
(Macintosh HD), and are referenced by the clone (Sandbox) using 
symlinks/aliases. 



36 

 

 
 

 

Once you’ve decided which of these two scripts to use, select it in the pop-
up. 

  

Now, click Options. Select Erase Sandbox, then copy files from 

Macintosh HD to ensure that any existing data on Sandbox is deleted 
before the copy is started, and select Start up from Sandbox to 
automatically restart from the Sandbox volume when the copy has been 
successfully completed. Everything else should be left unchecked. When 
complete, click OK. 

Whether you do it automatically or manually, starting up from 
Sandbox is a critical part of the operation. If you create the sandbox, 
but then never use it as your startup volume, your original system 
remains at risk! The whole point of the sandbox is to isolate the 
original system from anything that might happen to it: simply making 
the clone is not enough! So, make sure you use the Sandbox as 

your startup volume. 

The What’s going to happen? section describes exactly what SuperDuper 
will do. Always take a moment to verify that the proper options are selected, 
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and click Copy Now. The clone will take some time to complete. In this 
case, when done, SuperDuper will automatically set your startup disk to 
Sandbox and restart your Macintosh. (This behavior is optional, of course, 
and controlled by the Options… button, discussed below.)  

That’s all there is to it! When you run from the Sandbox volume, any 
changes you make to your own documents are available to both Macintosh 

HD and Sandbox, since those files are shared between the two volumes. 
Changes made to the system on Sandbox, however, are isolated to that 
volume alone, and cannot affect the system on Macintosh HD. 

Need to update an existing Sandbox? No problem! SuperDuper’s amazing 
Smart Update feature will update it in minutes. Simply boot back to the 
original and follow the steps above, substituting Smart Update from 

Macintosh HD to Sandbox for Erase Sandbox, then copy files from 

Macintosh HD. SuperDuper will automatically check each and every file and 
directory on Macintosh HD and Sandbox, copying any files added or changed 
on Macintosh HD to Sandbox. Any files that are on Sandbox that aren’t on 
Macintosh HD will be automatically deleted. 

When the Smart Update is complete, you’ll have exactly the same result as 
you would with Erase Sandbox…, but it will take a tiny fraction of the 
time. And, of course, Smart Update is perfect for updating a full backup 
clone from the original, too!  

Important Note 

Unless you’re certain you know what you’re doing, never, ever 

copy your Sandbox back over your original system. Doing so 
could delete your personal files and applications (which are stored on 
the original volume, and referenced by the Sandbox). 

Starting in v1.5 of SuperDuper!, we’ve made changes that allow 
advanced users to copy a Sandbox back to the original volume, using 
the “Backup – all files” copy script. However, this will only work if the 
Sandbox and all the shared files were created by SuperDuper! 

Please don’t attempt this if you’re not absolutely certain you know 
what you’re doing, and be sure you have a recent backup. 
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Maintaining a Sandbox 
It’s important to remember that applications installed into the “System” 
folder – /Applications – are specific to the volume you’re running on. If you 
install an application while running from the Sandbox clone, that application 
will not be available when running from Macintosh HD. 

Simple applications (typically those with “drag and drop” installs) can simply 
be copied to the original volume once you’re sure they’re safe. More complex 
applications (typically those with installers) might put files in many locations 
on your system. When you want to add those to your original volume, you 
select it as your startup drive, restart your Macintosh, and install it using its 
installer. You need not re-clone unless you want to save the space on 
Sandbox. 

Usage Tip 

Here at Shirt Pocket, we keep any new application images and 
packages installed since making the Sandbox in a folder on the 
desktop. 

Since the desktop is part of the shared user files, it’s available to both 
the original volume and the sandbox. When it’s time to “synchronize” 
the original, it’s only necessary to restart from the original volume, 
install the applications in this folder, and then update the Sandbox 
with Smart Update. 

 

Advanced Users 

If the Sandbox is working the way you want, you can also update the 
original volume by “copying back”. To do this, while booted from the 
Sandbox: 

• First, please back up the original drive in case you make a mistake. 

• Select the Sandbox as the source volume, and the original drive as 
the destination. 

• Choose "Backup - all files" as the script 

• Choose Smart Update as the During copy method. You must 
choose Smart Update for this to work properly. And, whatever you 
do, do not choose Erase, then copy. 

• Click Copy Now to perform the copy. 

This will update the OS and applications, but will not overwrite 
anything that was shared by SuperDuper! 
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Applying (and recov ering from) System  Updates while 
running fro m a Sandbox 
One of the best features of a Sandbox is that it isolates your real system 
from changes to the OS. Should you find any kind of incompatibility, you can 
easily restart your system from the original volume, which was not modified 
when the update was applied. 

Because of this, you can safely accept system updates when they appear. If 
you encounter any sort of problem, restart from the original volume – which 
wasn’t touched. 

When you have a moment, you can re-clone and restart from your Sandbox 
volume. Use Smart Update rather than Erase Sandbox, then copy… and 
it’ll only take minutes. When it’s done, everything should work exactly as it 
did before. You’re ready for the next – hopefully fixed – update! 

If, on the other hand, the System Update worked wonders, you can easily 
apply it to your original Macintosh HD volume at your leisure. 

Important Note 

Unless you’re certain you know what you’re doing, never, ever 

copy your Sandbox back over your original system. Doing so 
could delete your personal files and applications (which are stored on 
the original volume, and referenced by the Sandbox). 

Starting in v1.5 of SuperDuper!, we’ve made changes that allow 
advanced users to copy a Sandbox back to the original volume, using 
the “Backup – all files” copy script along with Smart Update. However, 
this will only work if the sandbox, and the shared files are created by 
SuperDuper! 

Please don’t attempt this if you’re not absolutely certain you know 
what you’re doing, and be sure you have a recent backup. 
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Sav ing and resto ring settings 
If you have a number of different copy or backup tasks that you want to 
accomplish on a regular basis, it can be a pain to reset the various options 
each time you load SuperDuper! Fortunately, SuperDuper! has an answer for 
those who have registered the program: the ability to save and restore your 
choices in a “settings file”. 

A settings file includes the source and destination volumes, selected Copy 
Script, and all of the options selected in the Options… page. Once you’ve 
set these the way you want, simply choose Save from the File menu (or 
press Cmd-s). Give your settings a name, and you’re done. 

The next time you want to perform the same operation, open SuperDuper! 
and choose Load settings… from the File menu (or use the Open Recent 
menu). SuperDuper! will load your saved settings: after verifying your 
selections in the What’s going to happen? section, simply click Copy 

Now! 

You can also start SuperDuper! with a given set of settings by double-
clicking the appropriate settings file in the Finder. By default, the settings 
files are stored off your Home folder in Library/Application 

Support/SuperDuper!/Saved Settings. 

Note 

When SuperDuper! loads your settings, it attempts to restore your 
source and destination volumes. If the volume isn’t currently mounted 
(for example, if you had backed up to a sparse image or a removable 
drive), SuperDuper! will try to automatically mount it. 

If that’s not possible, SuperDuper! will present a sheet and prompt you 
to mount the volume. Once it detects the volume has been mounted, 
the sheet will automatically be dismissed. If the volume isn’t available, 
click Cancel. 
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SuperDuper!  Optio ns in detail  
The Options… view allows you to customize many aspects of SuperDuper’s 
operation without delving into the world of Copy Scripts (see the next 
section). Let’s go through each option, one by one – first, in the Basic tab, 
and then in Advanced. 

Basic Options 

 

The Before copy options occur before the main copy operation takes place. 
Repair permissions on Macintosh HD (or whatever your source volume is 
called) verifies and corrects any permission problems before copying files. 

If you don’t know what this is, don’t worry about it! 

Typically, you don’t need to repair permissions manually – the operating 
system attempts to ensure that permissions are maintained correctly at all 
times. If, however, you wish to make sure that your on-disk permissions are 
as OS X expects them to be before making your clone, check this box. 

Note that this is mostly a time saver, since you can use OS X’s built-in Disk 
Utility to repair permissions outside the context of SuperDuper. In general, 
no harm can come from repairing permissions, but it does take a significant 
amount of time to complete. 

 

The During copy options control how SuperDuper processes the files that 
the Copy Script selects for copying. 

Erase Sandbox, then copy files from Macintosh HD first erases the 
destination (in this case, Sandbox), and then copies all of the selected files 
from the source. (Sandbox and Macintosh HD will be replaced with the 
names of the source and destination volumes you selected in the main 
window.) This is usually what you want, since it ensures that the files you’ve 
selected on the source are the only ones present on the destination when 
the operation is complete. 
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Smart Update Sandbox from Macintosh HD is the best way to update an 
existing Sandbox (or backup stored on Sandbox) from the original on 
Macintosh HD. SuperDuper quickly evaluates the files on the original and the 
clone, and automatically makes any changes on the clone necessary to make 
it an exact copy again. Smart Update will copy any files that differ Macintosh 

HD to Sandbox, whether newer or older, and will remove any files on 
Sandbox that don’t exist on Macintosh HD, the original. The result is exactly 
what you’d get if you chose Erase Sandbox, then copy files from 

Macintosh HD, but SuperDuper only makes the changes necessary to 
achieve this result – typically copying far fewer gigabytes! 

Important Note 

As we said above, the result of a Smart Update will be exactly what 
you’d get if you chose Erase Sandbox, then copy files from 

Macintosh HD. That means that any files “outside” the set of files 
selected by the copy script will be erased. 

For example, let’s say you did an initial copy using Backup – all files. 
Then, later, you decided to try to only “update” your user files the 
Backup – user files script. 

Remember that the result of a Smart Update will be exactly what you’d 
get if you chose Erase Sandbox, then copy files from Macintosh 
HD with the same script. That means that all files on Sandbox other 
than the ones selected by Backup – user files will be deleted! 

Instead, you should choose the same script you used previously: 
Backup – all files. SuperDuper will automatically skip any files that 
didn’t change, so you’ll end up copying the smallest amount of data 
possible to make Sandbox match Macintosh HD again. 

If you want to merge the contents of the source with the destination, you 
should choose Copy newer files… or Copy different files….  In this case, 
SuperDuper will overwrite any pre-existing files with the same name on 
Sandbox with newer or different files from Macintosh HD, skipping files that 
have the same date on Macintosh HD, and adding any from Macintosh HD 
that are not present on Sandbox. Any files on Sandbox that do not exist on 
Macintosh HD are left alone. 

Note that for a bootable copy, you should always use either Erase, then 

copy… (for the first copy) or Smart Update (to update an existing copy): 
it’s extremely important to ensure that any “old” files on the clone are 
removed. 
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On successful completion options run at the very end of a successful 
copy. Here you can have SuperDuper! 

Do nothing, which is just like it sounds. 

Restart from Sandbox, which sets the destination volume as the startup 
volume and restarts your Macintosh. 

Set Sandbox as startup disk sets the destination as the startup volume 
but does not restart the computer. 

Shut Down computer, Sleep computer and Quit SuperDuper! are 
pretty self-explanatory. 

 

Advanced Options  

There’s a single Before copy option under Advanced that allows you to run 
a shell script or other Unix executable just before the copy begins. This 
script can perform any operation you can think of. Like, for example, 
something we didn’t! (Or, more seriously, exporting a MySQL database or 
similar activity.) 

When SuperDuper executes the script, it passes it six parameters: 

1 The name of the source volume (e.g. Macintosh HD) 

2 The mount path of the source volume (e.g. /) 

3 The name of the destination volume (e.g. Sandbox) 

4 The path of the destination (e.g. /Volumes/Sandbox) 

5 The name of the script the user selected (e.g. Copy – all files) 
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6 The name of the image file being processed, if any. This could be either 
a source image (if copying from an image to a volume) or a destination 
image (if copying from a volume to an image), or a post-copy image 
(selected in the After copy options, below) 

After copy options are run immediately after the Copy Script has finished, 
and are typically used to perform operations on the fresh destination 
volume. 

Create a disk image of Sandbox will create a quickly restorable disk 
image (DMG file) of your destination volume immediately after the copy has 
finished. This is typically used in a lab situation where you’ve got a real 
reference image, and need a DMG file to image a series of other computers. 

This DMG file is fully ASR (“Apple Software Restore”) compliant, and can be 
used to restore the destination volume to this fresh state within minutes 
(restoring one of these images is much, much faster than doing a “file-by-
file” copy). 

However, you will pay for this time savings later with additional time up-
front. In the case of a Sandbox, you’d typically use a Smart Update 
instead: it’ll take less time up front and during the restore. 

When you check this box, SuperDuper will prompt you for the name and 
location it should use to store the disk image file. This location cannot be on 
the destination volume. 

Usage Tip 

If you’re a developer, testing the same clone in a number of different 
situations, you could use the Sandbox – shared users and 

applications script, and store a restorable image in your Documents 
folder for easy future access. Remember, though, that this image is 
only used to save time if you want to re-clone the exact same image 
later on – and in most situations that start from an existing “base”, 
Smart Update will be faster. 

Software testers can also use this option to save an image of a 
“standard configuration” they’ve just created. With a few clicks, this 
image can be restored to exactly duplicate a volume’s state before a 
test was executed. 
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Install package on Sandbox is very useful if you want to create a copy (or 
Sandbox) and then install a Software Update or other package to the 
destination volume. As with Repair permissions… above, this option is 
intended as a timesaver more than anything else, as you can perform this 
operation yourself after SuperDuper has finished. 

Important Note 

During beta or “seed” testing, some packages will not install properly 
to a partition other than the one you’ve booted from. If you see, in any 
release notes, a comment along the lines of “relocated applications will 
not update properly…”, do not use the Install package… option. 

To be absolutely safe, unless you’re sure – or have confirmed that it 
works with the package author – always reboot from the target 
partition before installing a package. 

When you select Install package…, SuperDuper prompts you for the 
location of the package file you want to install. This can be located on a 
mounted disk image, or any location other than the source. 

Note 

Package installation occurs after any disk image is created. This allows 
the disk image described above to be used to quickly restore to pre-
package status. 

 

As with the Before copy options, Run shell script after copy completes 
allows you to select any shell script or other executable, and run it after the 
copy, image and install actions have completed. The parameters passed in 
are identical to the ones above. 
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Copy Scripts 
While SuperDuper works great as shipped, with scripts that satisfy the 
typical user, there are those of you out there – and you know who you are – 
who have needs that are more unique. Fortunately, we have a solution: 
Copy Scripts. 

SuperDuper’s Copy Scripts allow file-level control of copying, and can be 
built up in stages. You don’t have to completely rewrite an existing script (or 
set of scripts) to handle a new situation: SuperDuper comes with a rich set 
of standard script building blocks that you can use as a basis for your own. 
Simply “include” some of these scripts to collect a group of files, and then 
fine-tune the result for a new situation. Or, start from scratch: it’s up to you. 

Note 

You shouldn’t modify the built-in scripts. If you want to modify the 
behavior of a built-in script, include the script and override its actions 
in the Commands section instead. 

Doing so will ensure that you’ll benefit from any modifications we 
made to the built-in scripts in subsequent releases of SuperDuper! 

If you must modify a built-in script, do not overwrite the existing copy: 
save it to the user “Copy Scripts” folder instead (the save dialog will 
automatically default to the correct location — ~/Library/Application 
Support/SuperDuper!/Copy Scripts). 

Copy Scripts aren’t scripts in the way shell scripts are. Rather, they provide 
you with a flexible way to select a set of files, and the actions to perform on 
the files in that set. Once those files are selected, SuperDuper “executes” 
the result. 

Let’s see how this works by creating a script that shares some large files 
from Final Cut Pro 4 to save space on a Sandbox. 
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First, we’ll create a new Copy Script using the File Menu (or use the shortcut 
Cmd-n). There are three sections to the editor: Description, Included Scripts 
and Script Commands. 

 

The Description tab allows you to provide text to the user when they select 
the script in the main window. It’s best to give a clear description of the 
intent of the script to ensure that the user isn’t surprised by the end result. 

You can use the placeholders (source) and (target) (with the parentheses 
included) to refer to the two volumes selected in the main interface. This 
gives the user more context for the script’s actions, and is preferred to using 
generic terms like “source” or “destination”. 

Scripts that aren’t intended to run on their own can be hidden from the user 
by unchecking Allow the user to select this script. Once done, the script 
will not be shown to the user in the Scripts pop-up. 
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The Included Scripts tab allows you to select one or more “building block” 
scripts that should collect a group of files that you want to refine in your new 
script. All scripts get a list of every file on the source drive, and are allowed 
to modify the commands assigned to each file (which, by default, is to copy 
the file – see the discussion of Script Commands, below). After one script 
has made changes, the resulting set of files and commands is passed to the 
next script in the list, from top to bottom, so subsequent scripts can modify 
or override the actions taken by the ones above. 

 

Note 

It’s important to remember that every file on the drive is always 
included in the set of files passed from one script to another. Scripts 
only modify the actions SuperDuper takes when it encounters the file. 
These actions are explained in the Script Commands discussion, below. 
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In our case, we’re going to base our script on the standard “Sandbox – 
shared users and applications” script. To include it, click the + button, and 
choose “Standard Scripts”. Then, choose “Sandbox – shared users and 
applications” from the list of scripts. 
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The script will appear in the list of included scripts. 

 

Tip 

If there are multiple scripts in the list, you can rearrange them by 
dragging and dropping. 
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At this point, the script will work exactly like the Sandbox – shared users 

and applications script, which isn’t quite what we want. To customize it 
further, let’s move on to the Script Commands tab. 

 

The upper table is a list of the commands that are specific to this particular 
script. Each row has a column that contains the command to apply to the file 
specification, which follows. This command can be: 

• Copy – makes a copy of the matching files on the target (the default 
action) 

• Ignore – doesn’t copy the matching files to the target 

• Share – shares the files on the source with the target  

Technical Note 

Sharing, for those technically inclined, causes the file or directory on 
the destination to be symbolically linked (a type of alias) to the same 
file or directory on the source. 
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The Item Specification column allows you to select the exact files this 
particular script command operates on. This entry supports wildcards, so you 
can easily create complex specifications to handle almost any situation you 
can come up with. 

There are four general types of wildcards that can be used in an item 
specification: 

• * -- Matches zero or more characters 

• ? – Matches any single character 

• […] – Matches any character in the brackets 

• [!...] – Matches any character except the ones in the brackets 

Within brackets, ranges of characters can be separated with -, e.g. [0-9], 
[!a-zA-Z], etc. 

Technical Note 

For those of you who are into this kind of thing, SuperDuper’s  
wildcards conform to standard Unix file ‘globbing’ specifications. For 
those of you who don’t know what ‘globbing’ means, don’t worry about 
it! 

The one thing you should keep in mind is that ‘*’ won’t match files that 
start with ‘.’ – this means that to treat all files specially, you’d need to 
include both ‘*’ and ‘.*’. 

Let’s look at a few examples that will hopefully make this clearer: 

• matches all files in the root directory, except those that begin with 
‘.’. 

• Applications/Retrospect * would match everything in the 
Applications directory that starts with “Retrospect ” (note the 
space) – e.g. “Retrospect Express”, “Retrospect Client” and 
“Retrospect 5.1”, but not “Retrospect”. 

• Applications/Retrospect [1-9].[0-9] would match “Retrospect 
5.1”, “Retrospect 5.0” and “Retrospect 6.3”, but not “Retrospect 
0.1” or “Retrospect 5.33”. 

Below the table is a helpful file browser that makes it easier to add a 
command to the table. To add a given item to the table, you locate it in the 
browser and then click Add Item. Do not add the drive name or the 
Volumes directory to the table, since the appropriate drive is always added 
in front of your file specification. Note that you can edit an Item Specification 
by double-clicking it in the table. 
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To continue with the example, I’d like to share the rather large Soundtrack 
Loops directory installed by both Final Cut 4 and Soundtrack between my 
original volume and my Sandbox. So, I select the directory in the browser 
and click Add Item. 

The default command is ignore, which is not what we want. Instead, click 
on it and change it to share. 

 

This will end up sharing the “Soundtrack Loops” directory, and everything in 
it, from the source to the target volume. 
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If, instead, I wanted to share everything within Soundtrack Loops, but not 
the directory itself, I could use wildcards. Just double-click the item 
specification, and you can edit it at will.  

 

Changing it as above will continue to copy the directory “Soundtrack Loops”, 
but will share the contents of it. In this case, the directories “Apple Loops” 
and “PowerFX Loops” will be shared with the source. 

That’s all there is to it! Simply save the script with Cmd-s, giving it a 
descriptive name. Make sure to store it above the “Standard Scripts” 
directory. 

When this script is chosen, it’ll do everything that Sandbox – shared users 

and applications does, but in addition it will share those two directories in 
/Documents/Soundtrack Loops – and, should other directories appear in 
there in the future, it’ll share those as well, due to our use of a wildcard.  
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Appendix – Partitio ning Yo ur Lapto p fo r a Sandbox 
SuperDuper can make regular backups without any special setup: you just 
need something to copy from, and a drive – preferably external – to copy to. 
This works for desktop and laptop systems, because the drive need only be 
connected during the backup operation. 

But to create and use a Sandbox as easily as possible, you need to run from 
it. If you’re running on a laptop, and you want it to be portable, you’ll likely 
need to partition your internal drive. 

To do this, you need to have one of the following: 

• An erasable external FireWire drive large enough to hold a copy of 
your drive 

• A FireWire based Apple iPod you don’t mind erasing with enough 
space to hold a copy of your drive (since your music is being synced 
from a copy of iTunes, erasing your iPod won’t permanently erase your 
music – it can always be re-synced when you’re done) 

• Some other reliable way of backing up your data 

Partitioning your internal drive is not difficult, but it is a bit scary, because it 
can’t be done with your data “in place”: you need to move your data off the 
drive you want to partition, run Disk Utility to partition it (destroying the 
data that’s there), and then copy the data back. 

Note 

There are third-party products, such as Coriolis Software’s iPartition, 
that can actually partition the drive with the data in place. OS X, 
however, cannot do it itself. 

SuperDuper! is ideal for making the copy, since it can make a fully bootable 
backup of the original. You can then check to make sure the copy works 
properly before you destroy the original data by partitioning. That said, 
better safe than sorry – please be exceptionally careful when following these 
instructions. Although all data should be copied during this process, 

please take appropriate steps to backup any critical data on the 

drive. We take no responsibility for any data loss. 

Let’s get started! These steps will assume that you’ve got an external 
FireWire drive of some type, either a standalone drive or an Apple iPod. 

Step 1: Determine the space needed, and select a device 

First, check to see how much space you’re using on the drive you’re going 
to partition. To do so, select the drive in the Finder and press Cmd-i. You 
should see something like this: 
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As you can see, this drive is using about 11GB of drive space. You’ll need 
another drive with at least 11GB of space on which to clone it (such as a 15 
or 20GB iPod). The drive you select must be able to act as a startup disk. 

Step 2: Connect the device to your Macintosh 

Once you’ve located a device with sufficient space, attach it to your 
Macintosh. If it’s an internal drive, nothing else need be done. If it’s a 
FireWire device, plug it into your FireWire port. If your FireWire device is an 
iPod, you’ll need to check Enable FireWire disk use in iTunes’ iPod settings 
(with the iPod attached, click the button with the picture of the iPod in the 
lower right of the main iTunes window) to get it to show up as a mountable 
drive. 

Step 3: Use SuperDuper to clone your drive 

Next, start SuperDuper! Choose your boot drive source in the first (“from”) 
drop-down, and the FireWire destination (“to”) in the second. The script you 
should use is Backup – all files. 

At this point, you should see something like this: 
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Now, click Options…. Ensure that the During copy pop-up is set to 
Erase…, which will erase the destination volume before copying to it. 
Everything else should be unchecked, and Restart from… should be 
selected in the On successful completion section: 
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Click Done. SuperDuper will confirm your choices in the What’s going to 

happen? section of the window: 

 

When you’re certain that you’ve chosen the right options, press Copy Now. 
SuperDuper will copy all of the files from the source to the destination, and 
will reboot from the destination when it’s done. Since this will take some 
time, depending on the amount of data you’ve got, you may want to relax 
with a tasty beverage. 

Step 4: Verify the clone 

When SuperDuper is done, and your system has restarted from your 
FireWire device, take a moment to look around. Try a few applications to 
make sure they work properly, and verify that your data is, indeed, where it 
should be. It’s important to make sure you’re satisfied with the copy, 
because in the next step you’re going to repartition the original drive. 
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Step 5: Partition the original drive 

Once you’re satisfied that things on the copy are working the way they 
should be, it’s time to actually partition the original drive. To do this, launch 
Disk Utility (it’s located in /Applications/Utilities). Select the original disk, 
and switch to the Partition tab. You should see something like this: 

 

Choose 2 partitions from the Volume Scheme drop-down, and size the 
partitions so that about 75% of the space is allocated to the top partition, 
and about 25% to the bottom. The bottom partition should be about 10-
15GB, and the top should be at least large enough to contain your original 
data. Name the larger clone the same as your original drive (Apple names 
the startup disc Macintosh HD from the factory), and name the second drive 
something descriptive, like Sandbox. 

When you’re satisfied with your choices, click Partition, and Disk Utility will 
complete the partitioning operation. 
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Step 6: Restore your data to the original drive 

When the partitioning has completed, it’s time to use SuperDuper again to 
restore your data. 

Launch SuperDuper. Choose the startup disk in the source drop-down 
(“From”) and the larger of the two partitions in the second (“To”). The 
Backup – all files script and the options to erase and start up from the 
destination should already be selected; verify this by reviewing the What’s 

going to happen? text. 

When you’re satisfied with your choices, click Copy Now again… and, get 
yourself another tasty beverage. 

Step 7: Final verification. 

Once again, check to make sure your copy is functioning the way you expect 
it to by running some applications and checking your data. Things should 
work exactly as they did before you started the whole process. 
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